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Warranty

 

Printer Warranty

 

Tektronix warrants that the Phaser 750 Printer will be free from defects in materials and 
workmanship for a period of one (1) year from the date of shipment.  If the product 
proves defective during the warranty period, Tektronix, at its option, will:

(1) repair the product by means of telephone support or on-site service at no charge for 
parts or labor, 
(2) replace the product with a comparable product, or 
(3) refund the amount paid for the product, less a reasonable allowance for usage, upon 
its return. 

Under this product warranty, Customer must notify Tektronix or its authorized service 
representative of the defect before the expiration of the warranty period.  To obtain 
service under this warranty, the Customer must first contact Tektronix Telephone 
Support personnel or that of its authorized service representative.  Telephone Support 
personnel will work to resolve issues professionally and quickly, however the Customer 
must reasonably assist Tektronix or its authorized representative.  

If telephone support is unsuccessful, Tektronix or its authorized service representative 
will provide warranty repair at Customer's site without charge as provided below.  

 

■

 

Service is available anywhere within the United States for products purchased in 
the United States

 

■

 

Inside the European Economic Area, service is available within the customary 
on-site service area for products purchased in the EEA

 

■

 

Outside the US & EEA, service is available within the customary on-site service 
area in the country of purchase

A description of the customary on-site service area may be obtained from the local 
Tektronix subsidiary or authorized Tektronix distributor.  On-site service is at Tektronix 
or its authorized service representative’s sole discretion and is considered an option of 
last resort. 

If the Customer’s product contains features that enable Tektronix or its authorized 
service representative to diagnose and repair problems with the product remotely, 
Tektronix may request that Customer allow such remote access to the product.

In the maintenance of the product, Tektronix may use new or equivalent to new parts or 
assemblies for equal or improved quality.  All defective parts and assemblies become the 
property of Tektronix.  Tektronix, at its option, may request the return of these parts.



 

Consumables Warranty

 

 

Tektronix warrants that the Customer Replaceable Consumables (CRCs) will be free from 
defects in materials and workmanship for a period of ninety (90) days (six  (6) months 
where longer periods are required by law) from the date of installation, but not more 
than one (1) year from date of shipment.  Under this warranty, the Customer must notify 
Tektronix or its authorized service representative of the defect before the expiration of 
the warranty period.  TEKTRONIX MAY REQUIRE THAT THE DEFECTIVE CRC BE 
RETURNED TO A DESIGNATED TEKTRONIX DEPOT OR THE TEKTRONIX 
REPRESENTATIVE FROM WHICH THE CRC WAS ORIGINALLY PURCHASED.  Claims 
will be handled according to the current Tektronix procedure.

These warranties shall not apply to any defect, failure or damage caused by improper 
use or improper or inadequate maintenance and care. Tektronix shall not be obligated 
under these warranties: 

a) to repair damage resulting from attempts by personnel other than Tektronix 
representatives to install, repair or service the product unless directed by a Tektronix 
representative; 
b) to repair damage, malfunction, or degradation of performance resulting from 
improper use or connection to incompatible equipment or memory;
c) to repair damage, malfunction, or degradation of performance caused by the use of 
non-Tektronix printer supplies or consumables or the use of Tektronix supplies not 
specified for use with this printer;
d) to repair a product or CRC that has been modified or integrated with other products 
when the effect of such modification or integration increases the time or difficulty of 
servicing the product or CRC;
e) to perform user maintenance or cleaning or to repair damage, malfunction, or 
degradation of performance resulting from failure to perform user maintenance and 
cleaning as prescribed by Tektronix in its published materials;
f) to repair damage, malfunction, or degradation of performance resulting from use of the 
product in an environment not meeting the operating specifications set forth in the user 
manual;
g) to repair this product after the limit of its duty cycle has been reached; all service 
thereafter shall be billed on a time and material basis;
h) to replace CRCs that have been refilled, are used up, abused, misused, or tampered 
with in any way.

THE ABOVE WARRANTIES ARE GIVEN BY TEKTRONIX WITH RESPECT TO THIS 
PRODUCT AND ITS CUSTOMER REPLACEABLE CONSUMABLES IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS 
DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE OR ANY SIMILAR STANDARD IMPOSED BY APPLICABLE 
LEGISLATION. TEKTRONIX' RESPONSIBILITY TO REPAIR, REPLACE, OR OFFER A 
REFUND FOR DEFECTIVE PRODUCTS AND CUSTOMER REPLACEABLE 
CONSUMABLES IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE 
CUSTOMER FOR BREACH OF THESE WARRANTIES. TEKTRONIX AND ITS 
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF PROFITS) IRRESPECTIVE OF 
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE 
POSSIBILITY OF SUCH DAMAGES. 



 

For the software warranty please see the end user license agreement included with the 
software.

If you are an Australian consumer, you should be aware that the Trade Practices Act 
1974 and equivalent State and Territory legislation (collectively "the Acts") contain 
special provisions designed to protect Australian consumers.  Nothing in any Tektronix 
warranty material excludes or limits the application of any provision of any of the Acts, 
where to do so would contravene the Acts or cause any part of this warranty to be void.  
In this warranty material, an implied condition or warranty, the exclusion of which from 
a contract with a "Consumer" (as defined in the Acts) would contravene any provision of 
the Acts or cause any part or all of this warranty to be void, is called a "Non-excludable 
Condition".  To the full extent permitted by law, Tektronix’s sole and total liability to the 
customer for a breach of any Non-excludable Condition (including for any consequential 
loss suffered by the customer) is limited, except as otherwise stated herein, to (at 
Tektronix’ option) replacing or repairing the goods, or resupplying, or paying the cost of 
the resupply of, the services, in respect of which the breach occurred.  Subject to the 
above, all conditions and warranties which would or might otherwise be implied in a 
Consumer contract, whether by operation of statute, inference from circumstances, 
industry practice or otherwise, are excluded.  



 

User safety summary

 

Terms in manual: 
Caution: 

 

 Conditions that can result in damage to the product.  

 

Warning:

 

  Conditions that can result in personal injury or loss of life.

 

Use proper power source:  

 

Do not operate this product from a power source that applies 
more than the voltage specified.  To avoid fire hazard, use only the power cord specified 
for this product.  In hospital applications, grounding reliability can only be achieved by 
the use of a hospital grade power cord, and the equipment is connected to an equivalent 
receptacle marked “hospital only” or “hospital grade.”

 

Operation of product: 

 

 There are no user-serviceable parts inside the product.  Avoid 
electric shock by contacting a qualified service technician to repair the product.  Do not 
operate without the covers and panels properly installed.  Do not operate in an 
atmosphere of explosive gases or flammable mixtures.

 

Safety instructions: 

 

 Read all installation instructions carefully before you plug the 
product into a power source.

 

Terms on product: 

 

CAUTION:  A personal injury hazard exists that may not be apparent.  For example, a 
panel may cover the hazardous area.  Also applies to a hazard to property including the 
product itself.
DANGER:  A personal injury hazard exists in the area where you see the sign.

 

Care of product: 

 

 Disconnect the power plug by pulling the plug, not the cord.  
Disconnect the power plug if the power cord or plug is frayed or otherwise damaged, if 
you spill anything into the case, if product is exposed to any excess moisture, if product 
is dropped or damaged, if you suspect that the product needs servicing or repair, and 
whenever you clean the product.

 

Ground the product: 

 

 Plug the three-wire power cord (with grounding prong) into 
grounded AC outlets only.  For protection against electric shock, this product is 
classified Class I, and Type B where applicable.

 

Location of product: 

 

 Place the printer in a well ventilated area.  



 

Symbols as marked on product:

 

DANGER high voltage: 

 

  

 

Protective ground (earth) terminal:  

 

 

 

Hot surface on or in the printer.  Use caution to avoid personal injury: 

 

 

 

Use caution.  Refer to the manual(s) for information:

 

  

 

Warning

 

If the product loses the ground connection, usage of knobs and controls (and 
other conductive parts) can cause an electrical shock.  Electrical product 
may be hazardous if misused.  

 

Warning

 

For your protection, do not defeat any interlocks.
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Tektronix Supplies and Accessories

 

Note

 

Inside the printer, all handles, knobs, and other features that 
the user interacts with are blue.

When the front panel prompts you that a supply is low or needs to be 
replaced, make sure that you have replacements on hand. To order 
supplies and accessories, contact your local dealer or visit the 
Tektronix web site:

 

www.tek.com/Color_Printers/supplies/

0632-61

Toner
Cartridges

Toner
Door

Fuser
& Fuser
Roll

Front Panel
Display

Imaging Unit
& Main Charge
Grid

Front
Door

 

 

 
Supplies

http://www.tek.com/Color_Printers/supplies" target="_blank
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High Capacity Toner Cartridges

 

Item Part Number

 

Cyan

Magenta

Yellow

Black

016-1800-00

016-1801-00

016-1802-00

016-1803-01

 

Standard Toner Cartridges

 

Item Part Number

 

Cyan

Magenta

Yellow

Black

016-1804-00

016-1805-00

016-1806-00

016-1807-01

 

Main Change Grid

 

Item Part Number

 

Main Charge Grid 016-1665-00

33100-33

0236-44

 

  

 
Su

pp
lie
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Fuser

 

Item Part Number

 

110 volt

220 volt

016-1839-00

016-1840-00

 

Fuser Roll and Cleaning Pad

 

Item Part Number

 

Fuser Roll (with Cleaning Pad) 016-1843-00

Fuser Cleaning Pad 116-0329-00

33100-35

33100-36

 

 



 

4

 

Phaser 750 Color Printer 

 

   

   

 

Imaging Unit

 

Item Part Number

 

Imaging Unit (Color Imaging Kit) 016-1841-00

 

Transfer Kit

 

Item Part Number

 

Transfer Kit 016-1842-00

0236-41

0236-43
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Tektronix Professional Printing Paper

 

Item Size Description Part Number

 

Premium Color Printing 
Paper

A/Letter (U. S.)
8.5 x 11 in.

500 sheets 016-1368-00

Premium Color Printing 
Paper

A4 (Metric Letter)
210 x 297 mm

500 sheets 016-1369-00

Glossy Coated Paper A/Letter (U. S.)
8.5 x 11 in.

100 sheets 016-1704-00

Glossy Coated Paper A4 (Metric Letter)
210 x 297 mm

100 sheets 016-1705-00

Premium Cover Paper A/Letter (U. S.)
8.5 x 11 in.

100 sheets 016-1823-00

Premium Cover Paper A4 (Metric Letter)
210 x 297 mm

100 sheets 016-1824-00

 

Tektronix Transparency Film

 

Item Size Description Part Number

 

Premium A/Letter (U. S.)
8.5 x 11 in.

50 sheets 016-1427-00

Premium A4 (Metric Letter)
210 x 297 mm

50 sheets 016-1428-00

Standard A/Letter (U. S.)
8.5 x 11 in.

50 sheets 016-1431-00

Standard A4 (Metric Letter)
210 x 297 mm

50 sheets 016-1432-00

 

Tektronix Color Laser Labels

 

Size Description Part Number

 

A/Letter (U. S.)
8.5 x 11 in.

100 sheets / 30 labels per sheet
1.0 x 2.625 in. labels

016-1695-00

A/Letter (U. S.)
8.5 x 11 in.

100 sheets / 6 labels per sheet
3.33 x  4.0 in. labels

016-1696-00
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A4 (Metric Letter)
210 x 297 mm

100 sheets / 14 labels per sheet
38.1 x  99.1 mm labels

016-1688-00

A4 (Metric Letter)
210 x 297 mm

100 sheets / 8 labels per sheet
67.7 x 99.1 mm labels

016-1689-00

 

Paper Trays

 

Item Paper Capacity Part Number

 

A/Letter (U. S.) 250 sheets 436-0282-02

A4 (Metric Letter) 250 sheets 436-0283-02

U. S. Legal 250 sheets 436-0314-02

 

Transparency Trays

 

Item Part Number

 

A/Letter (U. S.) 436-0284-02

A4 (Metric Letter) 436-0285-02

 

Printer Station

 

Features Part Number

 

■

 

Ergonomic surface height

 

■

 

Provides storage for supplies

ZCARTA

 

Internal Hard Drive

Feature Part Numbers

■ Adds collation

■ User documentation on disk

■ Enhanced Job Accounting

■ Enhanced PhaserLink features

Z750HD

Tektronix Color Laser Labels

Size Description Part Number
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Automatic Duplex/Lower Tray Assembly

Features Part Number

■ Automatic duplex with the Duplex Unit

■ Lower Tray Assembly with:

■ 1 Paper Tray

■ 1 Transparency Tray

■ Increased paper-printing capacity

■ Increased printing versatility and convenience.

U.S./Standard: 
ZDPLX Option 00

Metric: ZDPLX 
Option 01

PhaserShare® Token Ring Network Card

Features Part Number

■ Easy to install

■ Token Ring connectivity

ZNBTR

Additional memory

Feature Part Numbers

Improved performance

■ 64 Mbytes

■ 128 Mbytes

ZMC64

ZMC128
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Print Quality Modes
You can select the Print Quality mode in the follow ways:

1. From the software driver. (This always overrides the front panel 
setting.)

2. From the printer’s front panel. Press Menu, scroll to Print Quality, 
press Menu, and select a Print Quality Mode. 

Black and White Converts all colors to black, white, and shades of 
gray. Prints at 1200 x 600 dpi. 

Fast Color Fastest color print mode. Prints at 600 x 600 dpi 
using only the cyan, magenta, and yellow toners; 
black is a composite color. Not recommended for 
black text.

Standard General-purpose mode for color printing. Prints at 
600 x 600 dpi using all four color toners. 
Transparencies are always printed in Standard mode 
even if another mode is selected.

Enhanced Produces superior text resolution and smooth colors. 
Prints at 1200 x 600 dpi. 

Premium Produces the highest-quality color prints at 1200 x 
1200 dpi. Available only on 750P, 750DP, and the 
750DX configurations.
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TekColor™ Color Corrections
You can select the TekColor™ Color Correction mode in the following 
ways:

1. From the software driver. (This always overrides the front panel 
setting.)

2. From the printer’s front panel. Press Menu, scroll to Print Quality, 
press Menu, and select a TekColor™ Color Correction.   

Automatic Optimizes colors for each element (text and graphics) on the 
page. Best all-purpose selection.

None No color correction applied. Use with printer specific (i.e., 
using the printer’s  PANTONE® Color chart) PANTONE® 
Colors or when no correction is desired.

Vivid Color Produces the brightest possible colors. Makes blue colors 
appear less purple. Use when printing transparencies.

sRGB Display Closest match to computer screen colors.

SWOP Press Specification for Web Offset Publications. Use to match U. S. 
press standards.

Euroscale 
Press

Use to match equivalent Imation Matchprint® proofs.

Commercial 
Press

Use to match commercial Imation Matchprint® proofs. Best 
choice for comps.

DIC Use to match Dai Nippon printing inks on coated paper.

Toyo Use to match commercial Toyo printing inks on coated 
paper.

Use Printer 
Setting

Uses the selection made at the printer's front panel.

To set a printer default TekColor correction:

■ At the READY menu, press Menu.

■ Scroll to Print Quality, press Menu.

■ Scroll to TekColor Correction, press Menu.

■ Scroll to the correction, press OK.

Features
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Paper Tips
Caution

Do not use any media designed for inkjet printers, especially 
inkjet coated paper and inkjet transparencies. Inkjet media is 
coated with a substance that will damage the fuser. Tektronix 
does not furnish warranty service for damage or malfunction 
caused by the use of non-Tektronix supplies or consumables. 
Always use Tektronix media that has been specially designed 
for use with Tektronix Laser Printers.

■ To prevent Jam-Wrong Media errors, load only paper in the PAPER 
tray and Tektronix transparencies in the TRANSPARENCY tray or 
Multi-Purpose tray.

■ If you have the Automatic Duplex/Lower Tray Assembly:

■ Insert the Duplex Unit only in the upper (a) slot.

■ Insert the TRANSPARENCY tray only into the middle (b) tray 
slot.

■ Insert the PAPER tray into the middle (b) or lower (c) slot.

■ Always use the Multi-Purpose Tray (d) for specialty media. 

■ When loading the Multi-Purpose Tray, the front panel 
automatically prompts you to select the media type and media 
size.

a
b

c

d

Legal

Paper

A/Letter

Paper

Duplex

0236-06

Pa
pe

r 
Ti

ps
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■ When you select a media tray by location (Upper, Middle, Lower, 
Multi-Purpose Tray), the printer picks from that tray, regardless 
of the tray’s media type or size. 

■ Always keep media in a sealed package to avoid the effects of 
humidity, which can affect print quality.

Letterhead
■ For printing letterhead: 

■ In the PAPER tray put this material face-down.

■ In the Multi-Purpose Tray put this material face-up.
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Supported page sizes and image area

The printer supports five media sizes, which you select in the Print 
screen (using a supported printer driver).

Margins

Media Page size Print area Top / 
Bottom

Sides

1 Letter 8.5 x 11 in. 8.21 x 10.56 in. .22 in. .14 in.

2 A4 210 x 297 mm 200 x 287 mm 5 mm 4.8 mm

3 Legal 8.5 x 14 in. 8.2 x 13.5 in. .23 in. .14 in.

4 Executive 7.25 x 10.5 in. 6.93 x 10.31 in. .22 in. .15 in.

5 #10 
Envelope

4.13 x 9.5 in.
(104.8 x 
241.3 mm)

3.8 x 9.2 in.
(96.5 x 233.7 mm)

.16 in.
(4.1 mm)

.14 in.
(3.6 mm)

2 3 4 51

0632-57
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Paper and Transparency Trays

Paper Tray  

■ 250-sheet capacity

■ 60 - 90 g/m2 (16 - 24 lb.)

■ Use Tektronix Premium Color Printing Paper or Premium Laser 
Bond Paper for best results.

■ Paper only. Do not load transparencies.

Note

Load only laser paper in the paper trays. Specialty papers 
such as Tektronix Glossy Coated Paper, Tektronix Premium 
Cover Paper, envelopes, and Tektronix Laser Labels must be 
loaded in the Multi-Purpose Tray.

Do not use transparency in the PAPER tray. This will result in 
a Jam-Wrong Media error.

PAPER

A4

0632-01

PAPER
A/Letter

PAPER
A4

PAPER
Legal

Trays
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Transparency Tray  

■ Use only Tektronix transparencies. See page 1 for supplies 
ordering information. For information on Tektronix 
transparencies, visit the Tektronix web site:

www.tek.com/Color_Printers/products/supplies/trans/index.html

■ Install the transparency tray only in the printer’s upper or middle 
tray slots. If this tray is installed in the lower tray slot, a front 
panel error occurs that stops the print job. The transparency tray 
must then be moved to the upper or middle tray slot.

Caution

Use of non-Tektronix transparencies can damage printer 
components or produce poor image quality.

Do not load paper in the Transparency tray, this will result in 
a Jam-Wrong Media error.

■ Tektronix transparencies

■ Use only Premium or Standard Tektronix transparencies (see 
page 1 for supplies ordering information)

■ 100-sheet capacity

TRANSPARENCY

A4

0632-02

TRANSPARENCY
A/Letter

TRANSPARENCY
A4

 

Tr
ay

s

http://www.tek.com/Color_Printers/products/supplies/trans/index.html target="_blank
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Loading Paper or Transparency Tray

Note

Place the side to be printed (for example, letterhead paper) 
face-down under the hooks.

1. Push down on the tray’s metal plate until it clicks, locking it in 
place.    

2. Fan the media to release sheets that are stuck together.    

PAPER

A4

0632-08

0632-09
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3. Place the media in the tray under the hooks.   

■ Letterhead: Load this material face-down under the tray 
hooks.

■ Transparencies: Place the Tektronix logo strip face-up under 
the transparency tray hooks. Use Tektronix transparencies 
only.  

4. Tray capacity:

a. Paper tray 250 sheets

b. Transparency tray 100 sheets 

5. Insert the tray.

■ For tray placement guidelines, see page 10.

Caution

Keep the media level below the indicator on the tray’s 
label; otherwise, the printer may jam or be damaged.

TRANSPARENCY

A4

MAXIMUM TRAY LEVEL

0632-10
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Multi-Purpose Tray

Overview

Always use the Multi-Purpose Tray for speciality media; it supports 
the following media types:  

Supported Media Tray capacity Media thickness 
switch

Paper and Paper 2nd Side
75-105 g/m2, (20-28 lb.)

100 sheets Thin

Tektronix Transparency Film 50 sheets Normal

Tektronix Glossy Coated Paper 30 sheets Normal

Heavy paper:

■ Cover Stock

■  120-163 g/m2), (40- 60 lb.)

■ Index Stock

■ 120-163 g/m2, (60- 90 lb.)

■ Card Stock

■  120-163 g/m2, (32- 40 lb.)

30 sheets Thick

Tektronix Color Laser Labels 30 sheets Thick

#10 Envelopes 10 envelopes Thick

M
ulti-Purpose Tray
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Note

For the best coverage when using laser paper heavier than 
105 g/m2 (28 lb.) in the Multi-Purpose Tray, select Heavy 
Paper as the media type.

If the printer experiences frequent media jams at the 
Multi-Purpose Tray, move the Media Thickness Switch to a 
thicker setting. If the printer experiences frequent 
double-feed errors at the Multi-Purpose Tray, move the 
Media Thickness Switch to a thinner setting.

 
 

Note

The printer prompts you for the paper type and size. If the 
wrong media is selected, the printer’s front panel displays a 
Jam-Wrong Media message.

Thin ThickNormal

33100-68

M
ul

ti-
Pu

rp
os

e 
Tr

ay
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Loading the Multi-Purpose Tray
1. Pull out the slide and adjust the guides for the width of the media. 

2. Adjust the Media Thickness switch for the media you are using 
(see page 17). 

0632-11

Thin ThickNormal

33100-68
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3. Insert the media:

■ For Tektronix Transparencies place the Tektronix strip 
facing down and refer to page 23.

■ For Tektronix Color Laser Labels, place face-up and refer to 
page 28.

■ For envelopes, place face-up and refer to page 25.

■ For letterhead, place face-up and refer to page 11.  

4. The front panel prompts you to select the media type and then the 
media size:

Tektronix Transparency 

0632-63

Tek Transparency
OK

Letter or A4
OK

0632-44
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Tektronix Glossy Coated Paper 

Tektronix Premium Cover Paper  

Tektronix Color Laser Label 

Paper

■ Letterhead

■ Office Laser Paper

■ Standard paper and letterhead 75 - 105 g/m2 (20 - 28 lb.) 

Tek Glossy Coated Paper
OK

Letter
OK

0632-45

or A4

Heavy Paper
OK

Letter
OK

0632-64

or A4

Tek Labels
OK

Letter
OK

0632-47

or A4

Paper
OK

Letter
OK

0632-48

Legal, A4,
or Executive
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Paper 2nd Side

■ Standard paper and letterhead 75 - 105 g/m2 (20 - 28 lb.) 

Heavy Paper

■ Cover Stock 120-163 g/m2 (60 lb.)

■ Index Stock 120-163 g/m2 (90 lb.)

■ Card Stock 120-163 g/m2 (40 lb.) 

Envelope #10 

5. In the Print screen (using a supported driver), select 
Multi-Purpose Tray. Send the job to the printer.

Paper-2nd Side
OK

Letter
OK

0632-49

Legal, A4,
or Executive

Heavy Paper
OK

Letter
OK

0632-50

Legal, A4,
or Executive

Envelope
OK

# 10
OK
0632-51
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Loading Special Media

Tektronix Transparencies 
1. Set the Media Thickness Switch to Normal.

2. Adjust the tray’s guides for the width of your Tektronix 
Transparencies.

3. Insert the transparency with the logo strip face-down, entering 
the printer first. 

Thin ThickNormal

33100-68

0632-16

Special M
edia
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4. Fill the Multi-Purpose Tray to the level indicator on the guide 
(maximum capacity is 50 sheets). 

5. At the front panel’s media type prompt, scroll to Tek 
Transparency and press OK. Scroll to the media size Letter or A4.  

6. In the application’s Print screen under Tray Selection or Paper 
Source, depending on the driver, select the Multi-Purpose Tray 
and send the job to the printer. 

0236-13

3

4

Tek Transparency
OK

Letter or A4
OK

0632-44
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Printing #10 Envelopes
1. Prepare each envelope: tuck in the envelope flap. 

2. Adjust the printer’s media thickness switch to Thick. 

3. Adjust the printer’s media guides for the width of your envelopes. 

4. Insert the envelopes (maximum capacity is 10):

a. Short end enters first.

0632-22

Thin ThickNormal

33100-69

0632-24

Place
Stamp

Here

Place
Stamp

Here

Envelopes
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b. Side to be printed is face-up.

c. The edge where you place the stamp enters the printer first 
in some applications; make a test print before proceeding.

5. At the front panel prompt, scroll to Envelope then scroll to #10 
and press OK. 

6. In your application create a document with these measurements:

■ Width: (104.1 mm), 4.13 in. 

■ Length: (241.3 mm), 9.5 in.

■ Margins: (5 mm), 0.2 in. 

7. Access the Page Setup menu and make these selections: 

■ Paper Size: #10 Envelope

■ Orientation: Landscape

8. In the Print screen, use the supported printer driver, and make 
this selection:

■ Paper Source: Multi-Purpose Tray

9. Send the job to the printer.

Envelope
OK

# 10
OK
0632-51

En
ve

lo
pe
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Guidelines for envelope printing:

Caution

Never use envelopes with windows or metal clasps; they will 
damage the printer. Use envelopes that are at least #10-size. 
(4.13 x 9.5 in. /104.8 x 241.3 mm)

■ Do not print on the envelope’s back side.

■ Keep unused envelopes in their packaging to avoid the 
effects of moisture and dryness, which can affect print 
quality and cause wrinkling.

■ Many applications include a tool for creating an envelope 
document. For example, Microsoft Word includes an 
Envelopes and Labels feature under the Tools menu. Make 
sure that you select Face Up; select the feed method icon 
showing the stamp end entering the printer first, with the 
image centered; and unselect Clockwise Rotation.

■ Print a maximum of ten envelopes at a time.

■ Use envelopes that are at least #10-size 
(4.13 x 9.5 in. / 104.1 x 241.3 mm).

■ No plastic windows or metal clips.

■ No exposed gummed surfaces.

■ Single-sided printing only.

■ Keep unused envelopes in their original packaging.

Note

This printer is not made to handle high-capacity production 
envelope printing. Envelopes may wrinkle depending on 
weight and stiffness of the envelope.
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Printing on Tektronix Color Laser Labels
At the printer: 
1. Adjust the printer’s media thickness switch to Thick. 

2. Insert the label sheets (maximum capacity is 30 sheets):

a. Side to be printed is face-up.

b. The top of the sheet enters the printer first. 

Thin ThickNormal

33100-69

0632-26
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3. At the front panel prompt, scroll to Tek Labels and press OK, then 
scroll to the media size Letter or A4. 

In the application:

Note

For printing Tektronix Color Laser Labels, you can use 
common software settings.

4. If your application has a setting for Avery® labels, use it as a 
template. Otherwise, refer to the instructions included with the 
labels for margin settings. Use the Avery template for the 
Tektronix labels.

5. In the Print screen, use the supported print driver, and select:

■ Paper Source: Multi-Purpose Tray and send the job to the 
printer.

Labels

Template Tektronix Labels

Letter:

5160 016-1695-00 (30 per sheet)

5164 016-1696-00 (6 per sheet)

A4:

L7163 016-1688-00 (14 per sheet)

L7165 016-1689-00 (8 per sheet)

Tek Labels
OK

Letter
OK

0632-47

or A4

 

Labels
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Guidelines for printing on labels:
■ Use Tektronix Color Laser Labels.

■ If any of the labels on a sheet are missing, do not use that 
sheet; it may damage printer components.

■ When selecting Tek Label as the media type, the printer 
requires that room temperature be cooler than 27 degrees C 
(81 degrees F). If the temperature is above this, the printer 
reports an error and stops printing.

 

La
be

ls
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Automatic 2-Sided Printing
Caution

Never put media in the Duplex Unit; the printer reports a 
media jam.

Use only laser bond paper for automatic two-sided printing 
in the paper tray. Do not use any special media (glossy coated 
paper) to print automatic two-sided printing. Two-sided 
printing can be done manually; refer to Manual 2-Sided 
Printing From the Multi-Purpose Tray on page 35.

Automatic two-sided printing requires that the Lower Tray Assembly 
be installed.

1. Make sure that the Duplex Unit is inserted in the printer’s upper 
(a) slot. 

2. Load 75 - 90 g/m2 (20 - 24 lb.) paper in the paper tray.

If you are using pre-printed paper, such as letterhead:

a. Place the first side to be printed face-down.

a

b

c
Legal

Paper

A/Letter

Paper

Duplex

Paper

0632-27

2-Sided Prints
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b. Place the top of the page under the paper tray’s hooks.
This example shows letterhead paper. 

3. Insert the paper tray in the printer’s middle (b) or lower (c) tray 
slots.

Note

For best results with two-sided printing, use 90 g/m2 (24 lb.) 
laser paper.

4. Decide on a binding preference (how the page turns) for Step 5: 

a. Long-Edge binding or uncheck Bind on top edge. 

PAPER

A4

1 234567

0632-28

a

b

0632-29

2-
si
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d 
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b. Short-Edge binding or check Bind on top edge. 

5. In the Print screen, select the 2-Sided Printing option and a 
binding preference:

PC Drivers:

Windows 95/ Windows 98

a. From the File menu, select Print.

b. Click Properties.

c. Click the Setup tab.

d. Click Print on 2-Sides option.

e. Check or uncheck Bind on top edge.

Windows NT4

a. Start/Settings/Printers.

b. Right-mouse-button-click on your printer’s icon.

c. From the pop-up menu, select Document Defaults.

d. Click the Advanced tab.

e. Under Paper/Output, select Print on Both Sides.

f. Select Long Side or Short Side.

0632-30
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Macintosh Drivers:

LaserWriter 8.6

a. From the File menu, select Print.

b. From the pull-down menu, choose Layout.

c. Select Print on Both Sides.

d. Select a binding preference. 

LaserWriter 8.3.4

a. From the File menu, select Print.

b. Click the Options button.

c. Select 2-Sided Printing.

d. Select Short-Edge Binding or Long-Edge Binding.

6. Send the job to the printer.
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Manual 2-Sided Printing From the 
Multi-Purpose Tray
Side 1

Caution

Use only laser bond paper for the automatic two-sided 
printing in the paper trays. The Multi-Purpose tray should be 
used for manual two-sided printing on Tektronix Premium 
Color Printing Paper, Tektronix Glossy Coated Paper, or 
Heavy Paper. Two-sided printing on specialty media can 
shorten component life. For opacity and feed reliability, use 
laser paper that is 90 g/m2 (24 lb. bond). For best results, do 
not use heavy toner coverage on Side 1 of a manual 2-Sided 
Print; also, increase the top margin on Side 1 to at least 
12mm (or .5  in.).

■ For a multi-page document, print odd-numbered pages for Side 1. 
(This selection is application-specific).

1. Set the media thickness switch; refer to page 17 for the correct 
setting.
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2. Insert paper with the side to be printed face-up. 
This example shows letterhead paper. 

3. In the printer’s front panel, select the media type and size at the 
prompt. 

4. In the Print screen (using a supported driver), select 
Multi-Purpose Tray as the Paper Source or Tray Selection. Send 
the job to the printer.

5. Remove the printed paper from the output tray.

Front Panel Media Type

Paper ■ Standard laser paper, 75-105 g/m2 
(20-28 lb.)

Tektronix Glossy Coated 
Paper

■ Tektronix Glossy Coated Paper

Heavy Paper ■ Card stock, 120 - 150 g/m2 (32 - 40 lb.)

■ Cover stock, 120 - 150 g/m2 (40 - 54 lb.)

■ Index stock, 120 - 150 g/m2 (60 - 80 lb.)

■ Heavy laser paper, 120 - 150 g/m2 
(32 - 40 lb.)

32564-06

1 2 3 4 5 6 7
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Side 2

Note

For a multi-page document, print even-numbered pages for 
Side 2. (This selection is application-specific).

1. Insert the paper with the blank side face-up.  

2. In the printer’s front panel, select the media type and size at the 
prompt. 

3. In the Print screen (using a supported driver), select 
Multi-Purpose Tray as the Paper Source or Tray Selection. Send 
the job to the printer.

4. Remove the printed paper from the output tray.

32564-07

1 2 3 4 5 6 7
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Troubleshooting Print Quality
For detailed troubleshooting information, refer to the printer’s 
CD-ROM or the Tektronix Color Printer Knowledge Base web site:

www2.tek.com/TekSMART/

If you notice a problem with the quality of your prints, the probable 
solution is replacing one of the supplies. Keep in mind this basic 
guideline:

■ If the symptom appears in a single color:
Replace the Toner Cartridge.

■ If the symptom appears in all colors:
Replace the Imaging Unit, or Fuser, or Fuser Roll, or 
Main Charge Grid, or Transfer Kit. 

To diagnose the problem, check these items:

1. Check the front panel for messages on replacing supplies.

http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+750&PAGE=Color&PgName=TekSmart" target="_blank
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2. From the Help menu, scroll to Supplies Information, press OK 
and print the Supplies Page. Use it to diagnose and correct 
problems. The Supplies Page contains useful information, such as 
the remaining life for supplies. 

3. From the front panel Help menu, scroll to Print Quality, press 
Menu, scroll to Help Pages, press Menu, and print Diagnostic Test 
Pages. (This includes five color pages and one instruction page.) 
Examine the prints for symptoms.  

 Phaser® 750 COLOR PRINTER

Supplies Usage

Toner Cartridges

}

Toner Door

Fuser
& Fuser Roll

Front Panel Display

Imaging Unit
& Main Charge Grid

Front Door

Toner

Imaging Unit Main Charge Grid

Fuser Roll

Transfer Kit (located in paper feeder)

Fuser

Reorder: 016-1662-00

110V Reorder: 016-1660-00

Reorder: 016-1664-00

Reorder: 016-1665-00

Reorder: 016-1663-00

Black
Pages Remaining: >500 @ 5% coverage

Standard Reorder: 016-1807-00

Cyan

Hi-Capacity Reorder: 016-1803-00

220V Reorder: 016-1661-00

HEX XXX

HEX XXX

HEX XXX

HEX XXX

HEX XXX

Pages Remaining: >500 @ 5% coverage

Standard Reorder: 016-1804-00
Hi-Capacity Reorder: 016-1800-00

Magenta
Pages Remaining: >500 @ 5% coverage

Standard Reorder: 016-1805-00

Yellow

Hi-Capacity Reorder: 016-1801-00

Pages Remaining: >500 @ 5% coverage

Standard Reorder: 016-1806-00
Hi-Capacity Reorder: 016-1802-00

0% 50% 100%

 32%Life Remaining

Serial #:

Avg. Coverage/Image: 5.8%

Date Installed: Sep 1, 1999

0% 50% 100%

 %Life Remaining

0% 50% 100%

 64%Life Remaining

0% 50% 100%

 %Life Remaining

Date Installed:

Date Installed:

tektronix.com/Color_Printers/

Serial #:

Avg. Toner Coverage/Page: 13.3%

Date Installed: Sep 1, 1999

0% 50% 100%

 %Life Remaining

lack
Pages Remaining: >500 @ 5% coverage

Standard Reorder: 0
Hi-Capacity Reorder: 0

agenta
Pages Remaining: >500 @ 5% coverage

Standard Reorder: 0
Hi-Capacity Reorder: 0

0% 50% 100%

 32%Life Remaining

Serial #:

Avg. Coverage/Image: 5.8%

Date Installed: Sep 1, 1999

0% 50% 100%

 72%Life Remaining

Serial #:

Avg. Toner Coverage/Page: 13.3%

Date Installed: Sep 1, 1999

0632-56

0632-60

Test Print 

Black

Cyan

Magenta

Yellow

Print Q
uality
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Symptom: Problem in one color only
■ 1 color has many vertical streaks. 

■ 1 color has a light vertical streak. 

■ 1 color is light or faded. 

33100-61

33100-59

33100-58

Pr
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Solution: 

1. Adjust the color density.

a. Press Help, and scroll to Print Quality, press Menu, scroll to 
Calibrate Colors. Press Menu, scroll to Adjust Each Color. 
Press Menu. 

b. Adjust the density of the color that has problems.

2. Replace the Toner Cartridge of the color that has problems.
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Symptom: Problem in all four colors
■ Streak through all 4 colors. 

■ Spot in the same place on the page in all 4 colors. 

■ Random spots appear on every page. 

33100-57

33100-56

33100-55
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Solution:

1. The choice of media; check the following:

a. Use Tektronix media.

b. Use the correct media tray for the media you are using.

c. When using the Multi-Purpose Tray, select the correct media 
in the front panel.

2. Run Clean for Smudges. Press Help, scroll to Print Quality. Press 
Menu, scroll to Clean for Smudges. Press Ok and press Confirm.

3. Print about 25 blank pages until the problem disappears.

4. Replace Imaging Unit, or Fuser, or Fuser Roll.
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Symptom: All four colors are solid black

Prints are black (edge to edge). 

Solution: 

Remove then re-insert the Main Charge Grid. If problem persists, 
replace the Main Charge Grid.

Symptom: All four colors are extremely faded 

33100-54

33100-53
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Solution:

1. Choice of media; check the following:

■ Use Tektronix media.

■ Use the correct media tray for the media you are using.

■ When using the Multi-Purpose Tray, select the correct media 
in the front panel.

2. Relative humidity may be too low (below 30 percent relative 
humidity).

■ Refer to Calibrate for Paper in the printer’s front panel and run 
this mode:

■ Press Help, scroll to Print Quality, press Menu, scroll to 
Calibrate for Paper, press Menu, print the references pages. 
Follow the instructions on these pages and adjust the transfer 
setting.

3. Replace imaging unit or transfer kit.
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Symptom: Pieces of print image missing all four 
colors
1. Pieces of the printed image are missing and reappear out of place, 

approximately 129 mm (5 in.) down the page. 

2. Media frequently wraps around the Fuser (Jam at C). 

Solution:

1. Choice of media; check the following:

■ Use appropriate media in the correct tray location; refer to  
page 13 through page 28.

■ Print 10-20 blank pages of plain paper.

■ To avoid jams with Tektronix Transparencies, make sure 
that the logo strip is loaded face-down for the Multi-Purpose 
Tray and face-up for the Transparency tray.

2. If Jam at C, clear the media jam and run the front panel’s Clean for 
Smudges cleaning routine (5 blank pages will print to clean the 
roller). Press OK and then press Confirm.

3. Replace Fuser.

33100-67
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Media Jams

Preventing media jams
■ To reduce the frequency of paper and transparency jams, 

use Tektronix media and occasionally clean the rollers. From the 
Help Menu, scroll to Print Quality and press OK. Scroll to the 
Help Pages and press OK. Scroll to the Paper Tips and print and 
read the tips to avoid media jams.

■ When using the Multi-Purpose Tray, always set the media 
thickness switch for the media you are using. See page 17.

■ If the printer frequently reports Jam at Multi-Purpose, move the 
media thickness switch to a thicker setting.

Jam-Wrong Media
1. Check the trays to make sure that they contain the proper media.

a. Check all PAPER trays and remove all transparencies.

b. Check all TRANSPARENCY trays and remove all paper.

c. If printing from the Multi-Purpose Tray, make sure that the 
correct media type is selected from the front panel.

2. Open the left side door, remove the jammed media. See Jam at A 
illustrations.

Jam
s
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Jam at A

Solution 1

Open the left side door; remove the jammed media. 

Solution 2

Remove the media tray; remove the jammed media from inside the 
printer. 

33100-08

33100-09

Ja
m

s
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Jam at B (Lower Tray Assembly Only)

Solution 1

Open the lower left side door and remove the jammed media. 

Solution 2

Remove the selected media tray (middle or lower tray) and remove the 
jammed media from inside the printer. 

33100-10

A/Letter

Paper

A/Letter

Paper

33100-11
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Jam at C

Caution

The Fuser is hot. To avoid personal injury, use caution or 
wait for the Fuser to cool before touching it.

1. Remove the Fuser:

a. Open the printer’s front door.

b. To unlock the Fuser, turn the small blue thumbscrew 
counterclockwise.

c. At the lower left side of the Fuser, press the safety catch and 
slide the Fuser out of the printer. 

2. Remove the Fuser Roll:

a. To unlock the Fuser Roll, press out on the two tabs.

b. Lift the Fuser Roll out of the Fuser and set the roll aside. 

a b c

0632-31

a b

0632-32
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3. To release the jammed media, turn the Fuser’s large blue knob 
clockwise or counterclockwise. 

4. Remove the jammed media from the Fuser. 

5. Re-insert the Fuser Roll into the Fuser; re-install the Fuser.

6. The printer automatically prints five blank pages which cleans the 
fuser and then resumes the current print job.

0632-33

0632-34
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Jam at D

Caution

The Fuser is hot. To avoid personal injury, use caution or 
wait for it to cool before touching it.

Solution 1

1. Open the front door.

2. Pull open the access door; the media is visible.

3. Turn the Fuser’s large blue knob counterclockwise.

4. Remove the media. 

Caution

If the Fuser knob does not turn, do not force it or you may 
damage the Fuser. Instead, remove the Fuser and Fuser Roll; 
then turn the Fuser knob to release the jammed media.

.

A/Letter

Paper

0632-53

3 42
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Solution 2

1. Open the front door and the right side door. 

2. Turn the Fuser’s large blue knob counterclockwise.

3. Remove the jammed media. 

0632-35

0632-36

3

2
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Jam at E
Solution 1

Remove the jammed media from the output tray. 

Solution 2

Pull open the access door (above the plastic output tray) and remove 
the media. 

Note

Open and close the printer’s front door to clear the error 
message.

33100-15

A/Letter

Paper

A/Letter

Paper

33100-16
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Jam at Multi-Purpose Tray 

1. Remove all media in the Multi-Purpose Tray.

2. Remove the jammed media from the Multi-Purpose Tray.

3. Set the Media Thickness switch for the media you are using 
(page 17).

4. Re-insert the media in the Multi-Purpose Tray.

Note

To clear the error message, open and close the printer’s front 
door.

33100-17
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Jam at Duplex Unit
1. Remove the Duplex Unit (it is in the printer’s upper slot). 

2. Open the Duplex Unit. 

Note

If paper is not in the Duplex Unit, open the right side door; 
paper may be jammed there.

0632-37

0632-38
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3. Remove the jammed media. 

4. Close the Duplex Unit; press down to make sure that it snaps shut 
on both sides. 

5. Re-insert the Duplex Unit into the printer’s upper slot. 

0632-39

0632-40

0632-41
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Getting Help
Getting Help gives you a comprehensive set of instructions to solve 
printer problems. The printer's auto-running CD-ROM guides you to 
the various resources available for installing and learning more about 
your Tektronix color printer. Use the CD-ROM to install your printer 
driver software, view and print user documentation, and watch how-to 
videos. Live Internet links on the CD-ROM let you access the Tektronix 
Color Connection web site, your single source for color education, 
interactive tutorials, free templates and support information.

The front panel Help button:
■ Offers you a suite of tools along with information pages to 

help solve printing quality, media feed, supplies, and printer 
administration problems.

■ To print the two-page Help Guide: at the printer’s front 
panel, press Help, then press Print.

Printer CD-ROM 
■ Advanced Features and Troubleshooting Manual

■ Supplies instructions

■ Setup Guide poster

■ Video help

■ Networking manuals

■ Repacking instructions

■ Printer drivers

■ Material Safety Data Sheets (MSDS)
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Tektronix web site 

www.tek.com/Color_Printers/

■ Product and supplies information

■ Downloading printer drivers

■ Finding your local reseller

■ Online documentation

TekSMART™ Knowledge Base 

www2.tek.com/TekSMART/

■ Is the same troubleshooting knowledge base used by 
Tektronix Customer Support staff

■ Application issues

■ Networking issues

■ Printer errors

■ Print-quality issues

■ Troubleshooting

PhaserLink™ Software

www.tek.com/Color_Printers/products/phaserlink.html

■ View printer status using any web browser

■ Control printer settings

■ Link to online documentation via the World Wide Web

■ Requires network connection via TCP/IP
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http://www.tek.com/Color_Printers/" target="_blank
http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+750&PAGE=Color&PgName=TekSmart" target="_blank
http://www.tek.com/Color_Printers/products/phaserlink.html" target="_blank
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Color Connection

www.colorconnection.tektronix.com

Color resource for tools and information to help you get the most out of 
your color printer:

■ Interactive tutorials and helpful tips for using your printer 
and favorite software applications

■ Easy access to online technical support.

■ Customized features to meet your individual needs

Other online services 

      

  

Anonymous ftp server: ftp.tek.com/Color_Printers/

Subscribe to email update notices: www.colorconnection.tektronix.com

U. S. 
1-800-835-6100

Canada
1-800-563-1289

Outside U.S. and Canada
Contact your local 
Tektronix office for a list of 
local resellers

Customer Support Centers
U. S. and Canada
1-800-835-6100

Australia
1800 811 177

Austria
0 660 5804

Belgium
0800 1 5059

Denmark
80 01 81 76

Eastern Europe and 
the Middle East
+44 1908 681707

Finland
0800 1 14494

France
05 90 85 41

Germany
0130 82 10 68

Italy
1678 77261

Luxembourg
0800 2853

Norway
800 11782

Spain
900 97 4499

Sweden
020 795 177

Switzerland
155 9493

The Netherlands
06 0221647

UK
0800 558668

 

G
et

tin
g 

H
el

p

http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+750&PAGE=Color&PgName=Color" target="_blank
http://www.tek.com/cgi-bin/CPIDprinter?APP=CP&Model=Phaser+750&PAGE=Color&PgName=Color" target="_blank
ftp://ftp.tek.com/Color_Printers/" target="_blank
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Controlling Color Density
When colors look faded, adjust the toner color density to extend the 
life of the components. 

Print and use the Color Reference Page
1. In the printer’s front panel, press Help scroll to Print Quality. 

Press Menu, scroll to Calibrate Colors. Press Menu, scroll to 
Adjust Each Color. Press Menu, and print the Color Reference 
Page. 

2. Compare the Color Reference Page to the Color Density Samples. 
Make a note of the value (–10 to +10) for each color that most 
closely matches the samples. 

3. Adjust the density for each color: Enter the value noted in Step 2 
in the Calibrate Colors menu, under Adjust Each Color.

■ Decrease color density: Press <---.

■ Increase color density: Press --->.  

4. Reprint the Color Reference Page; check your adjustments.

Adjust Light/Dark Adjust Each Color

Calibrate Colors

MenuExit
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